
 

 
 

 

MQ-2 Semiconductor Sensor for Combustible Gas 

Sensitive material of MQ-2 gas sensor is SnO2, which with lower conductivity in clean air. When the 

target combustible gas exist, The sensor’s conductivity is more higher along with the gas concentration 

rising. Please use simple electrocircuit, Convert change of conductivity to correspond output signal of 

gas concentration. 

MQ-2 gas sensor has high sensitity to LPG, Propane and Hydrogen, also could be used to Methane 

and other combustible steam, it is with low cost and suitable for different application. 

Character Configuration 

*Good sensitivity to Combustible gas in wide range 

* High sensitivity to LPG, Propane and Hydrogen 

* Long life and low cost 

* Simple drive circuit 

Application 

* Domestic gas leakage detector 

* Industrial Combustible gas detector 

* Portable gas detector 
 
 
 
 

Technical Data Basic test loop 

T 

 
 
 
 
 
 
 
 
 
 
 
 

The above is basic test circuit of the sensor. 

The sensor need to be put 2 voltage, 

heater voltage（VH）and test voltage（VC）. 

VH used to supply certified working 

temperature to the sensor, while VC used 

to detect voltage (VRL) on load resistance 

（RL）whom is in series with sensor. The 

sensor has light polarity, Vc need DC 

power. VC and VH could use same power 

circuit with precondition to assure 

performance of sensor. In order to make 

the sensor with better performance, 

suitable RL value is needed: 

Power of Sensitivity body(Ps): 

Ps=Vc2×Rs/(Rs+RL)2 

Vc VRL 

RL 
VH 

GND 

Model No. MQ-2 

Sensor Type Semiconductor 

Standard Encapsulation Bakelite (Black Bakelite) 

Detection Gas Combustible gas and smoke 

 

Concentration 
300-10000ppm 

( Combustible gas) 

 

 
Circuit 

Loop Voltage Vc ≤24V   DC 

Heater Voltage VH 5.0V±0.2V ACorDC 

Load 

Resistance 

 

RL 
 

Adjustable 

 
 
 
 
 

Character 

Heater 

Resistance 

 

RH 
 

31Ω±3Ω（Room Tem.） 

Heater 

consumption 

 

PH 
 

≤900mW 

Sensing 

Resistance 

 

Rs 
 

2KΩ-20KΩ(in 2000ppm C3H8 ) 

 

Sensitivity 
 

S 
Rs(in air)/Rs(1000ppm 

isobutane)≥5 

Slope α ≤0.6(R5000ppm/R3000ppm CH4) 

 

 
Condition 

Tem. Humidity 20℃±2℃；65%±5%RH 

 

Standard test circuit 
Vc:5.0V±0.1V； 

VH: 5.0V±0.1V 

Preheat time Over 48 hours 

 



 

Resistance of sensor(Rs): Rs=(Vc/VRL-1)×RL 

 
 

 
Sensitivity Characteristics Influence of Temperature/Humidity 

 

 

Fig.1 shows the typical sensitivity characteristics of   Fig.2 shows the typical temperature and humidity 

the MQ-2, ordinate means resistance ratio of the sensor    characteristics. Ordinate means resistance ratio 

(Rs/Ro), abscissa is concentration of gases. Rs means  of the sensor (Rs/Ro), Rs means resistance of sensor 

resistance in different gases, Ro means resistance of in 1000ppm Butane under different tem. and humidity. 

sensor in 1000ppm Hyrogen. All test are under standard Ro means resistance of the sensor in environment of 

test conditions.  1000ppm Methane, 20℃/65%RH 

 
Structure and configuration 

Structure and configuration of MQ-2 gas sensor is shown as Fig. 3, sensor composed by micro AL2O3 ceramic tube, Tin 

Dioxide (SnO2) sensitive layer, measuring electrode and heater are fixed into a crust made by plastic and stainless steel 

net. The heater provides necessary work conditions for work of sensitive components. The enveloped MQ-2 have 6 pin, 4 

of them are used to fetch signals, and other 2 are used for providing heating current. 

Fig1 

  

 

 
 

 
 

 
 

 
 

 

 

 
 

Fig2 
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Notification 

1 Following conditions must be prohibited 

1.1 Exposed to organic silicon steam 

Organic silicon steam cause sensors invalid, sensors must be avoid exposing to silicon 
bond, fixature, silicon latex, putty or plastic contain silicon environment 

1.2 High Corrosive gas 

If the sensors exposed to high concentration corrosive gas (such as H2Sz, SOX，Cl2，HCl 

etc), it will not only result in corrosion of sensors structure, also it cause sincere sensitivity 
attenuation. 

1.3 Alkali, Alkali metals salt, halogen pollution 

The sensors performance will be changed badly if sensors be sprayed polluted by alkali 
metals salt especially brine, or be exposed to halogen such as fluorin. 

1.4 Touch water 
Sensitivity of the sensors will be reduced when spattered or dipped in water. 

1.5 Freezing 
Do avoid icing on sensor’surface, otherwise sensor would lose sensitivity. 

1.6 Applied voltage higher 

Applied voltage on sensor should not be higher than stipulated value, otherwise it cause 
down-line or heater damaged, and bring on sensors’ sensitivity characteristic changed badly. 

1.7 Voltage on wrong pins 

For 6 pins sensor, if apply voltage on 1、3 pins or 4、
6 pins, it will make lead broken, and without signal when 

apply on 2、4 pins 

 
2 Following conditions must be avoided 

2.1 Water Condensation 
Indoor conditions, slight water condensation will effect sensors performance lightly. 

However, if water condensation on sensors surface and keep a certain period, sensor’ 
sensitivity will be 
decreased. 

 
2.2 Used in high gas concentration 

No matter the sensor is electrified or not, if long time placed in high gas concentration, if 
will affect sensors characteristic. 

 
2.3 Long time storage 

The sensors resistance produce reversible drift if it’s stored for long time without electrify, 
this drift is related with storage conditions. Sensors should be stored in airproof without silicon 
gel bag with clean air. For the sensors with long time storage but no electrify, they need long 
aging time for stbility before using. 

 
2.4 Long time exposed to adverse environment 

No matter the sensors electrified or not, if exposed to adverse environment for long time, 
such as high humidity, high temperature, or high pollution etc, it will effect the sensors 
performance badly. 

 
2.5 Vibration 

Continual vibration will result in sensors down-lead response then repture. In 
transportation or assembling line, pneumatic screwdriver/ultrasonic welding machine can lead 
this vibration. 

 
2.6 Concussion 

If sensors meet strong concussion, it may lead its lead wire disconnected. 
 
2.7 Usage 

For sensor, handmade welding is optimal way. If use wave crest welding should meet the 
following conditions: 

2.7.1 Soldering flux: Rosin soldering flux contains least chlorine 
2.7.2 Speed: 1-2 Meter/ Minute 



 

2.7.3 Warm-up temperature：100±20℃ 

2.7.4 Welding temperature：250±10℃ 

2.7.5 1 time pass wave crest welding machine 
If disobey the above using terms, sensors sensitivity will be reduced. 

  



 

 

MQ135 Semiconductor Sensor for Air Quality Control 

Sensitive material of MQ135 gas sensor is SnO2, which with lower conductivity in clean air. When the 

target combustible gas exist, The sensor’s conductivity is more higher along with the gas concentration 

rising. Please use simple electrocircuit, Convert change of conductivity to correspond output signal of 

gas concentration. 

MQ135 gas sensor has high sensitity to Ammonia, Sulfide and Benze steam, also sensitive to smoke 

and other harmful gases. It is with low cost and suitable for different application. 

Character Configuration 
* Good sensitivity to Harmful gases in wide range 

* High sensitivity to Ammonia, Sulfide and Benze 

* Long life and low cost 

* Simple drive circuit 

Application 

* Domestic air pollution detector 

* Industrial air pollution detector 

* Portable air pollution detector 

 
 
 
 
Technical Data Basic test loop 

 

 

The above is basic test circuit of the sensor. 

The sensor need to be put 2 voltage, 

heater voltage（VH）and test voltage（VC）. 

VH used to supply certified working 

temperature to the sensor, while VC used 

to detect voltage (VRL) on load resistance 

（RL）whom is in series with sensor. The 

sensor has light polarity, Vc need DC 

power. VC and VH could use same power 

circuit with precondition to assure 

performance of sensor. In order to make 

the sensor with better performance, 

suitable RL value is needed: 

Power of Sensitivity body(Ps): 

Ps=Vc2×Rs/(Rs+RL)2 

Vc VRL 

RL 

VH 

GND 

Model No. MQ135 

Sensor Type Semiconductor 

Standard Encapsulation Bakelite (Black Bakelite) 

Detection Gas Ammonia, Sulfide, Benze steam 

 

Concentration 
10-10000ppm 

(Ammonia, Benze, Hydrogen) 

 

 
Circuit 

Loop Voltage Vc ≤24V   DC 

Heater Voltage VH 5.0V±0.2V AC or DC 

Load 

Resistance 

 

RL 
 

Adjustable 

 
 
 
 
 

Character 

Heater 

Resistance 

 

RH 
 

31Ω±3Ω（Room Tem.） 

Heater 

consumption 

 

PH 
 

≤900mW 

Sensing 

Resistance 

 

Rs 
 

2KΩ-20KΩ(in 100ppm NH3 ) 

Sensitivity S Rs(in air)/Rs(100ppm NH3)≥5 

Slope α ≤0.6(R100ppm/R50ppm NH3) 

 

 
Condition 

Tem. Humidity 20℃±2℃；65%±5%RH 

 

Standard test circuit 
Vc:5.0V±0.1V； 

VH: 5.0V±0.1V 

Preheat time Over 48 hours 

 



 

Resistance of sensor(Rs): Rs=(Vc/VRL-1)×RL 

 
 

 
Sensitivity Characteristics Influence of Temperature/Humidity 

Fig.1 shows the typical sensitivity characteristics of   Fig.2 shows the typical temperature and humidity 

the MQ135, ordinate means resistance ratio of the sensor    characteristics. Ordinate means resistance ratio 

(Rs/Ro), abscissa is concentration of gases. Rs means  of the sensor (Rs/Ro), Rs means resistance of sensor 

resistance in different gases, Ro means resistance of in 100ppm Ammonia under different tem. and humidity. 

sensor in 100ppm Ammonia. All test are under standard Ro means resistance of the sensor in environment of 

test conditions.  100ppm Ammonia, 20℃/65%RH 

 
 

Structure and configuration 

Structure and configuration of MQ135 gas sensor is shown as Fig. 3, sensor composed by micro AL2O3 ceramic tube, Tin 

Dioxide (SnO2) sensitive layer, measuring electrode and heater are fixed into a crust made by plastic and stainless steel 

net. The heater provides necessary work conditions for work of sensitive components. The enveloped MQ-4 have 6 pin, 4 

of them are used to fetch signals, and other 2 are used for providing heating current. 



 

Notification 

1 Following conditions must be prohibited 

1.1 Exposed to organic silicon steam 

Organic silicon steam cause sensors invalid, sensors must be avoid exposing to silicon bond, fixature, silicon 
latex, putty or plastic contain silicon environment 

1.2 High Corrosive gas 

If the sensors exposed to high concentration corrosive gas (such as H2Sz, SOX，Cl2，HCl etc), it will not only 

result in corrosion of sensors structure, also it cause sincere sensitivity attenuation. 

1.3 Alkali, Alkali metals salt, halogen pollution 

The sensors performance will be changed badly if sensors be sprayed polluted by alkali metals salt especially 
brine, or be exposed to halogen such as fluorin. 

1.4 Touch water 
Sensitivity of the sensors will be reduced when spattered or dipped in water. 

1.5 Freezing 
Do avoid icing on sensor’surface, otherwise sensor would lose sensitivity. 

1.6 Applied voltage higher 

Applied voltage on sensor should not be higher than stipulated value, otherwise it cause down-line or heater 
damaged, and bring on sensors’ sensitivity characteristic changed badly. 
1.7 Voltage on wrong pins 

For 6 pins sensor, if apply voltage on 1、3 pins or 4、6 pins, it will make 

lead broken, and without signal when apply on 2、4 pins 

 
2 Following conditions must be avoided 
2.1 Water Condensation 

Indoor conditions, slight water condensation will effect sensors performance lightly. However, if water 
condensation on sensors surface and keep a certain period, sensor’ sensitivity will be decreased. 

 
2.2 Used in high gas concentration 

No matter the sensor is electrified or not, if long time placed in high gas concentration, if will affect sensors 
characteristic. 

 
2.3 Long time storage 

The sensors resistance produce reversible drift if it’s stored for long time without electrify, this drift is related 
with storage conditions. Sensors should be stored in airproof without silicon gel bag with clean air. For the sensors 
with long time storage but no electrify, they need long aging time for stbility before using. 

 
2.4 Long time exposed to adverse environment 

No matter the sensors electrified or not, if exposed to adverse environment for long time, such as high 
humidity, high temperature, or high pollution etc, it will effect the sensors performance badly. 

 
2.5 Vibration 

Continual vibration will result in sensors down-lead response then repture. In transportation or assembling line, 
pneumatic screwdriver/ultrasonic welding machine can lead this vibration. 

 
2.6 Concussion 

If sensors meet strong concussion, it may lead its lead wire disconnected. 
 
2.7 Usage 

For sensor, handmade welding is optimal way. If use wave crest welding should meet the following conditions: 
2.7.1 Soldering flux: Rosin soldering flux contains least chlorine 
2.7.2 Speed: 1-2 Meter/ Minute 

2.7.3 Warm-up temperature：100±20℃ 

2.7.4 Welding temperature：250±10℃ 
2.7.5 1 time pass wave crest welding machine 

If disobey the above using terms, sensors sensitivity will be reduced. 
 

  



 
 

ESP8266 WiFi 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The ESP8266 is the name of a micro controller designed by Espressif Systems. The  

ESP8266 itself is a self-contained WiFi networking solution offering as a bridge from 

existing micro controller to WiFi and is also capable of running self-contained applications. 

This module comes with a built in USB connector and a rich assortment of pin-outs. With a 

micro USB cable, you can connect NodeMCU devkit to your laptop and flash it without any 

trouble, just like Arduino. It is also immediately breadboard friendly. 
 

 

 

 

 

 

 

 

 

 

 

 
 

 

 

 

 



 

Table of Contents 

1. Specification .......................................................................................................................................... 3 

2. Pin Definition ......................................................................................................................................... 3 

3. Using Arduino IDE ................................................................................................................................. 3 

 Install the Arduino IDE 1.6.4 or greater .................................................................................................. 4 

 Install the ESP8266 Board Package ................................................................................................ 4 

 Setup ESP8266 Support ................................................................................................................. 5 

 Blink Test ........................................................................................................................................ 7 

 Connecting via WiFi ........................................................................................................................ 9 

4. Flashing NodeMCU Firmware on the ESP8266 using Windows ............................................................ 12 

 Parts Required ................................................................................................................................... 12 

 Pin Assignment .................................................................................................................................. 12 

 Wiring ................................................................................................................................................ 13 

 Downloading NodeMCU Flasher for Windows .................................................................................... 13 

 Flashing your ESP8266 using Windows.............................................................................................. 13 

5. Getting Started with the ESPlorer IDE .................................................................................................. 15 

 Installing ESPlorer ............................................................................................................................. 15 

 Schematics ........................................................................................................................................ 18 

 Writing Your Lua Script ....................................................................................................................... 18 

6. NodeMCU GPIO for Lua .......................................................................................................................... 22 

7. Web Resources ....................................................................................................................................... 22 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 



 

1. Specification: 

 Voltage:3.3V. 

 Wi-Fi Direct (P2P), soft-AP. 

 Current consumption: 10uA~170mA. 

 Flash memory attachable: 16MB max (512K normal). 

 Integrated TCP/IP protocol stack. 

 Processor: Tensilica L106 32-bit. 

 Processor speed: 80~160MHz. 

 RAM: 32K + 80K. 

 GPIOs: 17 (multiplexed with other functions). 

 Analog to Digital: 1 input with 1024 step resolution. 

 +19.5dBm output power in 802.11b mode 

 802.11 support: b/g/n. 

 Maximum concurrent TCP connections: 5. 

 
2. Pin Definition: 

 

3. Using Arduino IDE 
 
 



 

The most basic way to use the ESP8266 module is to use serial commands, as the chip is basically a WiFi/Serial 

transceiver. However, this is not convenient. What we recommend is using the very cool Arduino ESP8266 project, 

which is a modified version of the Arduino IDE that you need to install on your computer. This makes it very 

convenient to use the ESP8266 chip as we will be using the well-known Arduino IDE. Following the below step to 

install ESP8266 library to work in Arduino IDE environment. 
 

 Install the Arduino IDE 1.6.4 or greater 
Download Arduino IDE from Arduino.cc (1.6.4 or greater) - don't use 1.6.2 or lower version! You can use your 

existing IDE if you have already installed it. 

You can also try downloading the ready-to-go package from the ESP8266-Arduino project, if the proxy is giving you 

problems. 
 

 Install the ESP8266 Board Package 
Enter http://arduino.esp8266.com/stable/package_esp8266com_index.json into Additional Board Manager URLs 

field in the Arduino v1.6.4+ preferences. 
 

Click ‘File’ -> ‘Preferences’ to access this panel. 
 

Next, use the Board manager to install the ESP8266 package. 
 
 
 
 
 
 

https://www.arduino.cc/en/Main/Software
https://www.arduino.cc/en/Main/Software
https://github.com/esp8266/Arduino
https://github.com/esp8266/Arduino
http://arduino.esp8266.com/stable/package_esp8266com_index.json


 

 
 

Click ‘Tools’ -> ‘Board:’ -> ‘Board Manager…’ to access this panel. 
 

Scroll down to ‘ esp8266 by ESP8266 Community ’ and click “Install” button to install the ESP8266 library package. Once 

installation completed, close and re-open Arduino IDE for ESP8266 library to take effect. 

 Setup ESP8266 Support 
When you've restarted Arduino IDE, select ‘Generic ESP8266 Module’ from the ‘Tools’ -> ‘Board:’ dropdown menu. 

 

 

Select 80 MHz as the CPU frequency (you can try 160 MHz overclock later) 
 
 
 
 



 

 

Select ‘115200’ baud upload speed is a good place to start - later on you can try higher speeds but 115200 is a good safe 

place to start. 

 
 
 

 
Go to your Windows ‘Device Manager’ to find out which Com Port ‘USB-Serial CH340’ is assigned to. Select the matching 

COM/serial port for your CH340 USB-Serial interface. 

 
 
 
 
 
 



 

 

 

Find out which Com Port is assign for CH340 Select the correct Com Port as indicated on ‘Device Manager” 
 

Note: if this is your first time using CH340 “ USB-to-Serial ” interface, please install the driver first before proceed the above Com 

Port setting. The CH340 driver can be download from the below site: 
 

https://github.com/nodemcu/nodemcu-devkit/tree/master/Drivers 
 

 

 Blink Test 
 
 

We'll begin with the simple blink test. 
 

Enter this into the sketch window (and save since you'll have to). Connect a LED as shown in Figure3-1. 
 
 
 

 
 

Now you'll need to put the board into bootload mode. You'll have to do this before each upload. There is no timeout for 

bootload mode, so you don't have to rush! 

 
 Hold down the ‘Flash’ button. 

 While holding down ‘ Flash’, press the ‘RST’ button. 

 Release ‘RST’, then release ‘Flash’ 

void setup() { 

pinMode(5, OUTPUT); // GPIO05, Digital Pin D1 

} 

 
void loop() { 

digitalWrite(5, HIGH); 

delay(900); 

digitalWrite(5, LOW); 

delay(500); 

} 

https://github.com/nodemcu/nodemcu-devkit/tree/master/Drivers


 

 When you release the ‘RST’ button, the blue indication will blink once, this means its ready to bootload. 
 

 
Once the ESP board is in bootload mode, upload the sketch via the IDE, Figure 3-2. 

 

 
Figure3-1: Connection diagram for the blinking test 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 
 

Figure 3.2: Uploading the sketch to ESP8266 NodeMCU module. 

The sketch will start immediately - you'll see the LED blinking. Hooray! 
 
 

 Connecting via WiFi 
 

OK once you've got the LED blinking, let’s go straight to the fun part, connecting to a webserver. Create a new sketch with 

this code: 

Don’t forget to update: 
 

const char* ssid = "yourssid"; 

const char* password = "yourpassword"; 
 

to your WiFi access point and password, then upload the same way: get into bootload mode, then upload code via IDE. 

 

 

 

 

// key in your own SSID 

// key in your own WiFi access point const char* password = "abc1234"; 

password 

= "handson"; const char* ssid 

/* 

* Simple HTTP get webclient test 

*/ 

 

#include <ESP8266WiFi.h> 



 
 

const char* host = "www.handsontec.com"; 

 

void setup() { 

Serial.begin(115200); 

delay(100); 

// We start by connecting to a WiFi network 

Serial.println(); 

Serial.println(); 

Serial.print("Connecting to "); 

Serial.println(ssid); 

 

WiFi.begin(ssid, password); 

 

while (WiFi.status() != WL_CONNECTED) { 
delay(500); 

Serial.print("."); 

} 
 

Serial.println(""); 

Serial.println("WiFi connected"); 

Serial.println("IP address: "); 

Serial.println(WiFi.localIP()); 

} 
 

int value = 0; 

 

void loop() { 

delay(5000); 

++value; 
 

Serial.print("connecting to "); 

Serial.println(host); 

 
// Use WiFiClient class to create TCP connections 

WiFiClient client; 

const int httpPort = 80; 
if (!client.connect(host, httpPort)) { 

Serial.println("connection failed"); 

return; 

} 
 

// We now create a URI for the request 

String url = "/projects/index.html"; 

Serial.print("Requesting URL: "); 

Serial.println(url); 

 

// This will send the request to the server 

client.print(String("GET ") + url + " HTTP/1.1\r\n" + 

"Host: " + host + "\r\n" + 

"Connection: close\r\n\r\n"); 
delay(500); 

 

// Read all the lines of the reply from server and print them to Serial 

while(client.available()){ 
String line = client.readStringUntil('\r'); 

Serial.print(line); 

} 
 

Serial.println(); 

Serial.println("closing connection"); 

} 

 

http://www.handsontec.com/


 

Open up the IDE serial console at 115200 baud to see the connection and webpage printout! 

 

 

That's it, pretty easy right ! This section is just to get you started and test out your module. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

4. Flashing NodeMCU Firmware on the ESP8266 using Windows 

 

Why flashing your ESP8266 module with NodeMCU? 
 

NodeMCU is a firmware that allows you to program the ESP8266 modules with LUA script. And you’ll find it very similar to 

the way you program your Arduino. With just a few lines of code you can establish a WiFi connection, control the 

ESP8266 GPIOs, turning your ESP8266 into a web server and a lot more. 

In this tutorial we are going to use another ESP8266 module with pin header adapter board which is breadboard friendly. 
 

ESP8266 Module Breadboard Friendly with Header Connector 
 

 Parts Required: 
 

 ESP8266 Module Breadboard Friendly 

 PL2303HX USB-UART Converter Cable 

 Some Male-to-Female Jumper Wires 
 
 

 Pin Assignment: 

 
 
 
 
 
 
 
 
 
 
 
 

 

http://handsontec.com/index.php/product/esp8266-module-bread-board-friendly/
http://handsontec.com/index.php/product/pl2303hx-usb-to-rs232-converter-cable/
http://handsontec.com/wp-admin/post.php?post=2964&amp;action=edit


 

 Wiring: 
 

 
 
 
 

ESP8266 Pin Description 

CH_PD Pull high, connect to Vcc +3.3V 

Vcc Power Supply +3.3V 

TXD Connect to RXD (white) of PL2303HX USB-Serial converter cable 

RXD Connect to TXD (Green) of PL2303HX USB-Serial converter cable 

GPIO0 Pull low, connect to GND pin 

GND Power Supply ground 

 

 
 Downloading NodeMCU Flasher for Windows 

 

After wiring your circuit, you have to download the NodeMCU flasher. This is a .exe file that you can download using one of 

the following links: 

 Win32 Windows Flasher 

 Win64 Windows Flasher 
 

You can find all the information about NodeMCU flasher here. 
 

 Flashing your ESP8266 using Windows 
 

Open the flasher that you just downloaded and a window should appear (as shown in the following figure). 

 

 

https://github.com/nodemcu/nodemcu-flasher/tree/master/Win32/Release
https://github.com/nodemcu/nodemcu-flasher/tree/master/Win64/Release
https://github.com/nodemcu/nodemcu-flasher/tree/master/Win64/Release


 

 
 
 

Press the button “Flash” and it should start the flashing process immediately, showing the Module MAC address if 

successful connected. 
 

After finishing this flashing process, it should appear a green circle with a check icon at lower left corner. 

 

Your ESP8266 module is now loaded with NodeMCU firmware. 
 

 



 

5. Getting Started with the ESPlorer IDE 

 
ESPlorer is an IDE (Integrated Development Environment) for ESP8266 devices. It’s a multi platform IDE, can be used in 

any OS environment, this simply means that it runs on Windows, Mac OS X or Linux. 

Supported platforms: 

 Windows(x86, x86-64) 

 Linux(x86, x86-64, ARM soft & hard float) 

 Solaris(x86, x86-64) 

 Mac OS X(x86, x86-64, PPC, PPC64) 

 
This software allows you to establish a serial communications with your ESP8266 module, send commands, and upload 

code and much more. 

 

 
Requirements: 

 You need to have JAVA installed in your computer. If you don’t have, go to this 

website: http://java.com/download, download and install the latest version. It requires JAVA (SE version 7 and 

above) installed. 

 In order to complete the sample project presented in this Guide you need to flash your ESP8266 with 

NodeMCU firmware. Refer to chapter-4 in this guide on how to flash the NodeMCU firmware. 

Main Resources: 

 ESPlorer Homepage: http://esp8266.ru/esplorer/ 

 GitHub Repository: https://github.com/4refr0nt/ESPlorer 

 

 
 Installing ESPlorer 

 

Now let’s download the ESPlorer IDE, visit the following URL: http://esp8266.ru/esplorer/#download 
 

Grab the folder that you just downloaded. It should be named “ESPlorer.zip” and unzip it. Inside that folder you should 

see the following files: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Execute the “ESPlorer.jar” file and the ESPlorer IDE should open after a few seconds (the “ESPlorer.jar” file is what you 

need to open every time you want to work with the ESPlorer IDE). 

 
 

http://java.com/download
http://esp8266.ru/esplorer/
http://esp8266.ru/esplorer/#download


 

Note: If you’re on Mac OS X or Linux you simply use this command line in your terminal to run the ESPlorer: sudo java –jar 

ESPlorer.jar. 

When the ESPlorer first opens, that’s what you should see: 
 

 

 
Here’s a rundown of the features the ESPlorer IDE includes: 

 Syntax highlighting LUA and Python code. 

 Code editor color themes: default, dark, Eclipse, IDEA, Visual Studio. 

 Undo/Redo editors features. 

 Code Autocomplete (Ctrl+Space). 

 Smart send data to ESP8266 (without dumb send with fixed line delay), check correct answer from ESP8266 

after every lines. 

 Code snippets. 

 Detailed logging. 

 And a lot more… 

 

 
The ESPlorer IDE has a couple of main sections, let’s break it down each one. 

In the top left corner you can see all the regular options that you find in any software. Create a New file, Open a new file, 

Save file, Save file as, Undo, Redo, etc. 
 

 

 



 

In the top right corner you have all the options you need to establish a serial communication (you’re going to learn how 

to use them later in this Guide). 
 

 

 
This next screenshot shows your Code Window, that’s where you write your scripts (your scripts are highlighted with your 

code syntax). 
 

 

 
Below the Code Window, you have 12 buttons that offer you all the functions you could possible need to interact with your 

ESP8266. Here’s the ones you’ll use most: “Save to ESP” and “Send to ESP”. 
 

 

This screenshot shows the Output Window which tells you exactly what’s going on in your ESP8266. You can see errors 

and use prints in your code to debug your projects. 
 

 



 

 Schematics 
 

To upload code to your ESP8266, you should connect your ESP8266 to your PL2303HX USB-UART Programming Cable like 

the figure below: 

 
 

 

 
 Writing Your Lua Script 

 

Below is your script to blink an LED. 
 

 
 

Right now you don’t need to worry how this code works, but how you can upload it to your ESP8266. 
 

lighton=0 

pin=4 

gpio.mode(pin,gpio.OUTPUT) 

tmr.alarm(1,2000,1,function() 

if lighton==0 then 

lighton=1 

gpio.write(pin,gpio.HIGH) 

else 

lighton=0 

gpio.write(pin,gpio.LOW) 

end 

end) 

http://handsontec.com/index.php/product/pl2303hx-usb-to-rs232-converter-cable/


 

Having your ESP8266+PL2303HX Programmer connected to your computer, go to the ESPlorer IDE: 
 

 

 
Look at the top right corner of your ESPlorer IDE and follow these instructions: 

 

1. Press the Refresh button. 

2. Select the COM port for your FTDI programmer. 

3. Select your baudrate. 

4. Click Open. 
 

 
 
 

Then in the top left corner of your ESPlorer IDE, follow these instructions: 

1. Select NodeMCU 

2. Select Scripts 

3. Create a new filled called “init.lua” 
 
 
 
 
 
 
 
 
 
 

 



 

 
 

Copy your Lua script to the code window (as you can see in the Figure below): 

 

 
 

The next step is to save your code to your ESP8266! 

At the left bottom corner click the button “Save to ESP”. 

In your output window, it should start showing exactly which commands are being sent to your ESP8266 and it should look 

similar to the Figure below. 

 

 

 

 

 

 

 

 

 

 

 

 



 

 
 

 

 

Note: If you want to delete your “init.lua” file, you can do that easily. Simply type file.remove(“init.lua”) and  press  the 

button “Send” (see Figure above). Or you can type the command file.format() to remove all the files saved in your ESP8266. 

You can type any commands and send them to your ESP8266 through that window. 

After uploading your code to your ESP8266, unplug your ESP8266 from your computer and power up the ESP8288 

module. 

 

 
 

 

 

 
Congratulations, you’ve made it! The blue LED at the upper right corner should be blinking every 2 seconds! 

 

 

 



 

6. NodeMCU GPIO for Lua 

 
The GPIO(General Purpose Input/Output) allows us to access to pins of ESP8266 , all the pins of ESP8266 accessed using 

the command GPIO, all the access is based on the I/O index number on the NoddMCU dev kits, not the internal GPIO pin, 

for example, the pin ‘D7’ on the NodeMCU dev kit is mapped to the internal GPIO pin 13, if you want to turn ‘High’ or 

‘Low’ that particular pin you need to called the pin number ‘7’, not the internal GPIO of the pin. When you are 

programming with generic ESP8266 this confusion will arise which pin needs to be called during programming, if you are 

using NodeMCU devkit, it has come prepared for working with Lua interpreter which can easily program by looking the 

pin names associated on the Lua board. If you are using generic ESP8266 device or any other vendor boards please refer 

to the table below to know which IO index is associated to the internal GPIO of ESP8266. 
 

Nodemcu 

dev kit 
ESP8266 Pin Nodemcu dev 

kit 
ESP8266 Pin 

D0 GPIO16 D7 GPIO13 

D1 GPIO5 D8 GPIO15 

D2 GPIO4 D9 GPIO3 

D3 GPIO0 D10 GPIO1 

D4 GPIO2 D11 GPIO9 

D5 GPIO14 D12 GPIO10 

D6 GPIO12   

 

D0 or GPIO16 can be used only as a read and write pin, no other options like PWM/I2C are supported 

by this pin. 

 
In our example in chapter 5 on blinking the blue LED, the blue LED in connected to GPIO2, it is defined 

as Pin4 (D4) in Lua script. 

 

 

 

7. Web Resources: 

 

 ESP8266 Lua Nodemcu WIFI Module 

 ESP8266 Breadboard Friendly Module 

 ESP8266 Remote Serial WIFI Module 

 PL2303HX USB-UART Converter Cable 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

http://handsontec.com/index.php/product/esp8266-lua-nodemcu-wifi-board/
http://handsontec.com/index.php/product/esp8266-module-bread-board-friendly/
http://handsontec.com/index.php/product/esp8266-remote-serial-wifi-module/
http://handsontec.com/index.php/product/pl2303hx-usb-to-rs232-converter-cable/
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